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Creating a Layout Using an Ocean-Centered Projection

Instructions
Use this guide and ArcGIS Pro to reproduce the results of the exercise on your own.

Note: The version of ArcGIS Pro that you are using for this course may produce slightly
different results from the screen shots that you see in the course materials.

Time to complete
Approximately 60-90 minutes

Software requirements
ArcGIS Pro 2.7
ArcGIS Pro Standard license (or higher)

Note: The MOOC provides a separate ArcGIS account (user name and password) that you
will need to use to license ArcGIS Pro and access other software applications used
throughout the MOOC exercises. This account (user name ending with _cart) provides the
appropriate ArcGIS Online role, ArcGIS Pro license, ArcGIS Pro extensions, and credits.
We strongly recommend that you use the provided course ArcGIS account to ensure that
you have the appropriate licensing to complete the exercises. Exercises may require
credits. Using the provided course ArcGIS account ensures that you do not consume your
organization's credits. Esri is not responsible for any credits consumed if you use a different
account. Moreover, Esri will not provide technical support to students who use a different
account.

Introduction

Some maps are designed to challenge our assumptions of the world and force us to look at
our world from a new and fresh perspective. Seventy-one percent of the earth is covered in
oceans but the vast majority of projections available to cartographers favor land areas. Seams
and distortion are relegated to the vast and empty oceans. But we know that oceans aren't
empty! There is a bustling community of scientists and advocates working to make the oceans
more familiar and more connected to how we consider our impact on them.

This exercise is a fun opportunity to explore a strange new projection that does just that. You
will make a beautiful map of the world's oceans, with a projection and layout designed to
present it in a novel and eye-catching way.
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What Will You Learn?

In this exercise, you will gain experience creating an ArcGIS Pro layout, populating it with map
frames, text, and images. You will learn how to rotate a map within a layout and explore color
gradient options for raster layers.

Step 1: Download the exercise data file

In this step, you will download the exercise data file.

a Open a new web browser tab or window.

b Go to https://bit.ly/3izmSo0 and click Download to download the exercise data ZIP file.

Note: The complete URL to the exercise data file is https://trainingservices.maps.arcgis.com/
home/item.html?id=1e15ab56677446a89e23cc66eb782946. The file is 18 MB.

c Extract the files to a folder on your local computer, saving them in a location that you will
remember.

Step 2: Open an ArcGIS Pro project

In this step, you will open ArcGIS Pro and the project that you will be working with for this
exercise.

a Start ArcGIS Pro and, if necessary, sign in using your provided course ArcGIS credentials
(user name ending with _cart).

b From the main ArcGIS Pro start page, near the bottom left, click Open Another Project.

c In the Open Project dialog box, browse to the location where you saved the exercise data
file and open the SpilhausLayout.ppkx project package.

Next, you will save a copy of the exercise project with a new name so that you do not
overwrite the original file.

d From the Project tab, click Save As and type a name for your project, such as
SpilhausLayout_<your first and last name>.aprx.

e Save the project to the folder on your computer where you are saving your work.
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You will see a map with charmingly simple land areas. This layer was hand-drawn by
cartographer Dylan Moriarty and accessed from the very fun and endlessly useful Project
Linework (http://www.projectlinework.org/).

f Zoom and pan around the map.

As you explore the layer, you can see it has an almost cartoonish level of generalization. This
effect is intentional; sometimes too much geographic detail clutters a small scale map (small
scale = large area; large area = small scale. This concept can be confusing, but a little trick
shared on Twitter by user @cartonaut (https://bit.ly/3a4hEgc) might help: If a map were a fish,
standing far away it looks like it has small scales, but up close it has large scales.).

The bathymetric (underwater terrain) layer comes from the General Bathymetric Chart of the
Oceans (GEBCO) (https://www.gebco.net/) and beautifully shows the rises (shallower areas
are light) and falls (deeper areas are dark) of the seafloor. This sort of image is called a digital
elevation model.

Step 3: Change the map projection

Recalling the exercise on working with map projections and coordinate systems, take note of
the uninspired appearance of the WGS84 coordinate system. Does it do a good job of
showcasing the massive and beautifully interconnected system of oceans that cover 71
percent of the earth's surface? Not really.

In this step, you will apply a fascinating projected coordinate system, designed specifically to
show that grand interconnectedness: the "Spilhaus World Ocean Map in a Square."
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What's a Spilhaus map? If you would like to learn more about the history of the Spilhaus map,
including who created it and why, and how it only recently became available to mapmakers,
check out this story (https://bit.ly/2LRNXX2). Or grab a copy of GIS for Science Volume 2
(https://www.gisforscience.com/), which features a Spilhaus map on its cover and describes
the very process of creating a Spilhaus layout (https://bit.ly/2Y0zb32) that you will be working
through in this exercise.

a Zoom to the full extent of the map.

Hint:Hint: From the Map tab, click the Full Extent button .

b In the Contents pane, double-click Map to open the Map Properties dialog box.

c Click Coordinate Systems.

d In the Search box, type Spilhaus and press Enter to refine the list of available coordinate
systems.

e In the XY Coordinate Systems Available box, expand Projected Coordinate System, and
then expand World.

f Click Spilhaus Ocean Map In Square to set the coordinate system

g Click OK.
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Hint:Hint: If the map draws very slowly on your computer, consider turning off the bathymetry
layer until later in the exercise. Often, with complex maps, a cartographer will turn on
complex layers only when they need to symbolize them or export the completed map.

The result is an understandably unfamiliar look at the world. As you have learned, all
projections distort some geographic properties and maintain others, depending on the
purpose of the map. Most projections prioritize land while seams and distortions are reserved
for bodies of water. Spilhaus does the opposite. Spilhaus presents the world's oceans as a
singular uninterrupted body of water—which they really are.
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Step 4: Create a map layout

Next, you will work on creating a layout that aims to visually prioritize oceans and employ an
attractive faded border to frame the ocean composition.

a On the ribbon, click the Insert tab.

b In the Project group, click the New Layout down-arrow

c At the bottom of the drop-down list, choose Custom Page Size.

d In the Layout Properties dialog box, change Page Units to Points.

e For Width, type 1000.

f For Height, type 1000.

g Click OK.

The result is a new empty square layout. A layout is like a fresh sheet of paper, waiting for any
number of maps, charts, text, and graphics to be arranged on it. Now, you will add the
Spilhaus map to the layout.

h If necessary, click the Insert tab.

i In the Map Frames group, click the Map Frame down-arrow and click the thumbnail
labeled Default Extent.

j On the layout, drag a square that is smaller than the layout square.

Cartography. MOOC

Copyright © 2021 Esri. All rights reserved. 6



Having a bit of room around the edge of your map frame is important because you will use
that extra space later.

This container that you have drawn is called a Map Frame. If you need to resize and reposition
your map frame, use the handles along its perimeter. If things go oddly or you are unhappy
with your map frame, you can delete the map frame (select it, then press the Delete key) and
insert it again. Understanding the nested nature of a layout, map frame, and map can take a
bit of practice.

Hint:Hint: You can zoom in and out on your layout with more control by right-clicking the layout
area while dragging the mouse up or down. If your mouse has a scroll wheel, you can click the
wheel button and drag your mouse to pan around the layout.

By default, a map frame has a thin black border. You do not want that for this map, so you will
delete it.
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k Right-click the map frame (either from the layout or the Map Frame item in the Contents
pane) and choose Properties.

l In the Format Map Frame pane, click the Display button

m Change the border symbol to 0 pt.

The black border is removed from the map frame.

n Close the Format Map Frame pane.

o If necessary, from the Layout tab, click the Full Extent button .

p Save your project.

You have added the map to a layout. Next, you will begin to adjust the appearance of the
map.

Step 5: Repeat a map frame

You now have a layout with a Spilhaus map of the world's oceans. But it could look much
better. Do you notice how the Gulf of Mexico (between North and South American at the
upper left section of the map) ends abruptly? It reappears along the bottom edge of the map.
Similarly, the Bering Strait on the right edge is clipped, and it appears again along the top of
the map. The placement of the edges may seem bizarre, but it's no more bizarre than most
maps cutting an imaginary line in the Pacific ocean and unwrapping the world so that the
seam splitting the Pacific is on the left and right side of the map.

You will make four copies of this map frame and place them along the edges so that you have
a sort of repeating pattern and no abrupt edges. This type of cartography is tricky and crafty,
which is the best sort.

Before you begin, if you would like to watch a video that walks through this process, you can
find it here (https://bit.ly/2Y7lTBP).

a In the Contents pane, right-click Map Frame and choose Copy.

b In the layout, right-click and choose Paste.

ArcGIS Pro will automatically name the copy Map Frame 1 so that it has a unique name.

c Manually position this second map frame so that it lines up along the left side of the
original map frame.

Hint:Hint: Zoom out if necessary.
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The Gulf of Mexico and North America appear uninterrupted.

d In the Contents pane, right-click Map Frame 1 and choose Copy.

e In the layout, right-click and choose Paste.

f Manually position this new map frame so that it lines up along the right side of the
original map frame.
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For these map frames to align correctly with each other, you will need to rotate the new map
frame's map. This technique is a very useful feature. It is useful for any map when the
geographic area does not match well with the layout's dimensions.

g In the Contents pane, under Map Frame 2, right-click Map and choose Properties.

Note: Do not right-click Map Frame 2 itself.

h If necessary, in the Map Properties dialog box, click the General tab.

i For Rotation, type 90.
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j Click OK.

Now the repeating map frames match up so that the geographic area is continuous and
uninterrupted. You will notice how Alaska and Siberia appear fully and correctly where these
two map frames meet. You may need to manually adjust the positions of the map frames
further so that they line up.

Next, you will add copies of the map frame along the top and bottom edges of the center
map frame. However, for these maps to line up, you will need to reverse the rotation angle to
-90°.

k Copy and paste any one of the existing frames and align it to the top edge of the center
map frame.

l In the Contents pane, under Map Frame 3, right-click Map and then choose Properties.

Note: Do not right-click Map Frame 3 itself.

The Map Properties dialog box opens.

m On the General tab, for Rotation, type -90.
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n Click OK.
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The map rotates 90 degrees in the opposite direction so that the world appears to be
seamless again.

o Notice how Alaska and Siberia align (they should look upside-down).

p Copy Map Frame 3, paste it to create a new map frame, and position the new frame
along the bottom edge of the center map frame.

Adding this frame unites the Gulf of Mexico along the bottom of the layout.

The result should be a layout with five map frames, which looks a bit like a flattened
cardboard box. You added the extra map frames so that the edges of the map would not end
abruptly. This solution means that some of the content is repeated along the perimeter of the
map. Much of cartography is going to great lengths to make a map look just right.

Step 6: Add a vignette overlay image

Now you will add an overlay image that frames in the ocean areas and provides a pleasant
faded edge to help focus the eye of the map reader.
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In the data download for this exercise were two images: a black overlay and a white overlay.
You will use one of the two images to create a vignette border for the layout.

a On the ribbon, click the Insert tab.

b In the Graphics And Text group, click the Picture button .

c In the Insert Picture window, browse to the location that you extracted the exercise data
to.

d Open the SpilhausVignetteOverlay folder, click one of the two image files, and then click
Open.

Note: You can choose whichever image file that you prefer; you can always change your
choice later.

e Click and drag a box on the layout to place the image.

f Use the handles on the image to resize and reposition the vignette frame (use the
following graphic as a guide).

Hint:Hint: With the image selected, hold the Shift key and use the arrow keys to move the image
within the layout. Hold the CTRL key and arrow keys to fine-tune its position.

Cartography. MOOC

Copyright © 2021 Esri. All rights reserved. 14



You have just assembled a beautiful Spilhaus map with an attractive faded coastal edge.
However, it could be even more beautiful. Next, you will customize the symbology of the land
and bathymetry to suit your tastes.

g Save your project.

Step 7: Add color to the map

This map, while a visually interesting composition, is a bit drab. The following instructions will
show you how to apply different colors to the land and bathymetry layers, but please feel free
to experiment with your own color choices and make something unique and wonderful.

a In the Contents pane, if necessary, collapse Map Frames 1, 2, 3, and 4.

b Under Map Frame, right-click Land (Moriarty Hand) and choose Symbology to open the
Symbology pane.

The Symbology pane is home to all manner of thematic and design options. For this exercise,
you will just focus on a small bit of its capabilities.

c In the Symbology pane, click the black square that represents the land polygon symbol.
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d At the top of the pane, click the Properties tab, and then click the Layers button .

e Under Appearance, click the Color down arrow and choose a color that looks good to
you.

Note: You can also choose Color Properties from the Color drop-down list to open a color
editor, which you can then use to fine-tune the color properties.

f Click Apply.
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Next, you will move on to the bathymetry colors. The bathymetry layer is an image where
depth is encoded into the pixel value. By default, digital elevation models (and bathymetry)
typically use a black (lowest elevation) to white (highest elevation) color scheme. Defaults are
a helpful start, but one of the greatest jobs of a cartographer is to carefully consider defaults
and, perhaps, change them to suit the imagination of the cartographer and best fit the needs
of the map.

g In the Contents pane, click the black-to-white gradient of the Bathymetry layer to open its
Symbology pane.

h Click the Color Scheme down arrow to see some of the available options, and then
choose one that you like.

As a general guideline, cartographers tend to choose a range of blues to represent
bathymetry—dark blues representing deeper areas and lighter blues representing shallower
areas.
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You can also create a custom gradient.

i Click the Color Scheme down arrow and choose Format Color Scheme.
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The Color Scheme Editor opens. This editor enables you to define a gradient's colors and
color position.

j Experiment with the Color Scheme Editor options to create a gradient that you think
beautifully represents oceanic depth.

k When you have a gradient that you like, click OK.
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Hint:Hint: Did you change your mind about the black or white overlay image? It is simple to
switch. Just double-click the overlay image to open the Format Picture pane, and then
change Simple Path to point to the image that you want to use.

Now that the map looks the way that you want it, you should add some more information to
it.

Step 8: Add elements to the map layout

Now it is time to name your map, cite its sources, and attach your name.

a On the Insert tab, in the Graphics And Text group, click the Rectangle Text button .

b Click in the layout and then type a title (for example, Spilhaus One World Ocean Map).

c In the Contents pane, right-click Text and choose Properties to open the Format Text
pane.

You may notice a red line under the word "Spilhaus." ArcGIS Pro includes spell-check
functionality.

d Right-click the text and choose Add To Custom Dictionary to remove the red line.

e In the Format Text pane, click the Text Symbol tab to customize how the text appears.

f Expand Appearance.

g Choose your own text appearance or set the following parameters:

• Font Name: Choose Century Gothic or another sans-serif font.

• Font Style: Verify that it is set to Regular.

• Size: Increase to 28 pt.

• Color: Choose a color that coordinates well with the map and is legible on the

background that you chose.

h If necessary, adjust the text placement on the layout.

Hint:Hint: Remember that you can get fine control over the placement of layout elements by
pressing the Ctrl key and using the arrow keys.

Cartography. MOOC

Copyright © 2021 Esri. All rights reserved. 20



Next, you will add a second text box for your name.

i Copy the text element that you just added, and then paste it on the layout, just below the
text box with the map title.

j Replace the text in the new text box with your name.

k Change the text color to a less eye-catching color than the title (for example, gray), and
then reduce the text size (for example, 22 pt.).
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Finally, you will add a third text box that will cite your sources.

l Use the same technique to copy the text element that you just added and paste it on the
layout.

m If you would like, change the text appearance (color, size, and so on.).

n Replace your name with a citation of the data sources used in the map:

• Land areas: Dylan Moriarty & Project Linework

• Bathymetry: GEBCO Compilation Group (2020)

o Place the text where you would like it on the map.
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Wonderful! You have just made a personalized Spilhaus map. Why keep it to yourself? Now it
is ready to be shared as an image.

Step 9: Export map layout as an image

Now that your layout has been finished, you will export it as an image file.

a On the ribbon, click the Share tab.

b In the Export group, click Layout.

Cartography. MOOC

Copyright © 2021 Esri. All rights reserved. 23



A new pane opens. There are a range of formats that you can export your map, but for this
exercise, you will use JPEG because JPEG format results in a reasonably small file size
convenient for sharing on the web (if you would like to do that).

c For File Type, choose JPEG.

d For Name, browse to a location that you can access, and then type
Spilhaus_Layout_<your first and last name> and click Save.

e Under Resolution, for DPI, type 100.
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f Click Export.

g After the export finishes, open File Explorer, browse to your image, and open it.
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You have created and exported a map that uses the Spilhaus projection.

Stretch goal

Are you feeling pretty confident in your layout and layer styling prowess? Would you like to
make a super-interesting and exciting Spilhaus map? Consider something from ArcGIS Living
Atlas of the World.

If you would like to continue working with the map that you just made, you can continue using
layout and layer styling to create an exciting Spilhaus map. Complete the following high-level
tasks:

1. From the ArcGIS Pro Add Data dialog box, choose the Living Atlas tab.

2. Search for marine to see many interesting oceanic layers that could live within your map.

• For additional rich layers, explore Natural Earth or install a set of scientific visualization

color gradients.

3. Select a layer to create a Spilhaus map.

Use the Lesson Forum to post your questions and observations. Be sure to include the
#stretch hashtag in the posting title.

If you did some experimenting on your own beyond the steps of an exercise, we would love
to hear about and see what you did! If you completed a map based on the exercise steps,
that is awesome! However, there is no need to share it in the Forum.

Learn More
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Here are some links to resources used in this exercise and other interesting and useful related
topics:

• The story behind the creation of the Spilhaus projected coordinate system (https://bit.ly/

2LRNXX2), written by Esri geodessists

• The life and work of Athelstan Spilhaus via this Wikipedia article (https://bit.ly/3p8MTge)

• How the Spilhaus map on the cover of GIS For Science Volume 2 (https://bit.ly/

3sW4OJA) was created

• The powerful capabilities of layouts in ArcGIS Pro (https://bit.ly/2LSzE53)

• How human eyes and brains work, and why rainbow color schemes don't do a very good

job of representing continuous data (https://bit.ly/3606zeK)

• A style file (https://bit.ly/3iHI1wo) for ArcGIS Pro that explains how to create ocean labels

like the ones in the Spilhaus map
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